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Overview

This article walks through the steps to use the new (released Oct. 2015) poll watching feature to flag voters, using your mobile device who are
voting in your current election.

The feature is bundled in with the rest of the Mobile Base Camp web app tools and can be accessed with an mobile device that has internet

connectivity, and a web browser.

« Tip: To save time you can create a single database user account with very limited security access for just poll watching. Then distribute the login
credentials between all of your poll watchers. This requires appropriate security clearance to setup new users (normally not a good practice with
your database but in this case if you limit the access correctly it makes the process much more efficient).
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Prerequisites

IMPORTANT: Prior to using this feature you need to:
- Contact our support team at (support@trailblz.com) or (1-866-909-8700) with the request to set you up with this feature from our end.
- Let us know which election in your database you need activated.

- If you only require certain precincts to be listed in the poll watching drop-down list, we’ll also need a list of those specific ones (this can be
especially common with a very large database).

We will activate the feature on our end, and also make sure that your precinct data is up-to-date, and that the naming convention of your precincts
is consistent.

« Tip: It's a good idea to request this sooner than later so that all of your volunteers have time to learn how to log in via their mobile device, and
how the results can be utilized with queries, and pivot reports once polling commences.
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Steps

Navigate to your Elections list, verify that the election you’re polling for is created (otherwise create a new one), and then contact us with the name

of the election you need activated. In my example | used my Primary 2016 election.
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If you only want certain precincts within your database to display in the drop-down on Mobile Base Camp you’ll need to send us that list as well.
This can be altered election by election on our end.

Your current list of precincts can be viewed by following Application Menu > System Manager > Lists > Precincts:
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Precinct list, where you can select which ones you need enabled for poll watching,
otherwise we'll enable all that are in the database.
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5 Lists Poll street2: -

@ Account Types
-\:=| Candidates

Pall City:
Poll State:

@ Elections, Vioter History
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Organize. Leverage. Succeed.

If you don’t want to go through and select which precincts to include in the poll watching app we’ll enable all that are in the database.

Once these steps are finished, we’ll update you that it’s ready (this can take anywhere from a couple hours to a few days depending on the size of

the database).

As soon as we give you the go-ahead you can have your poll watchers log into Mobile Base Camp at www.trailblz.info/YourDatabaseName/Mobi -

in my example | logged in at http://www.trailblz.info/democampaign_joel/mobi.
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(Your secure login is hosted at www.trailblz.info/YourDatabaseName/mobi)

L (' | % @ hitps;//trailblzinfo/democamy 7 | G ||Q Search | * =] ¥+ H 4 »

S

|0 TBZ

TRAILBLAZER"
Mobile Base Camp

Username:
|
Password:

(3¢) Login BaseCamp
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This is what it looks like prior to poll watching being activated:
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Trail Blazer Home

Application Menu

Search Voter

PinPoint Canvassing

=

This feature of Mobile Base Camp will

display as [Inactive] until you put in the request
to our support department that we enable

the election for 'Poll Watching'.

Email: support@trailblz.com
Phone: 1-866-909-8700
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Once we complete the steps above it will look like this:
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Trail Blazer Home

Application Menu

Search Voter
PinPoint Canvassing

Poll Watching

N\

Once we set you up on our end the
Poll Watching feature becomes activated.
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Click on the [Poll Watching] button, and select the precinct from the drop-down where you will be stationed. In my example | chose the first one in
my list “Alliance 1-A”.
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Poll Watching

Select Precinct: Precincts Total: 309
(v

ALLIAMCE 1-A N

ALLIANCE 1-B

ALLIANCE 1-C
ALLIANCE 1-D

Select the precinct ALLIANCE 2.A

ALLIAMCE 2-B

from the drop-down ALLIANCE 2.C

. ALLIANCE 2-D
H ALLIANCE 3-A
where you'll be stationed.| ALaicEsA
ALLIANCE 3-C
ALLIAMNCE 3-D
ALLIANCE 3-E
ALLIANCE 4-A
ALLIANCE 4-B
ALLIANCE 4-C
ALLIAMNCE 4-D
ALLIANCE 4-E
ALLIANCE 4-F -
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Tap on the [Start Polling] button to proceed.
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Poll Watching

Select Precinct: Precincts Total: 309

ALLIANCE 1-A (v}

Precinct Name: ALLIANCE 1-A
Tracking 473 voters in precinct

Start Polling Total amount
of precincts
\ enabled for

Number of voters poll watching.

to poll in this Tap this button after selecting
precinct. the precinct.
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You can search by Last Name as voters finish voting, then tap on their record to open it. In my example | searched this precinct for “Anderson” and
selected “John H Anderson”.
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ALLIANCE 1-A £ Options

(@ Anderson

@ Previous (& NextPage Search by last name.

Page 1 of 1

Anderson, John H
©

143 Ely StE \

Clear search.

Tap on the voter's record after they vote
so you can flag them as having voted.
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Check the box for Voted, and then tap on [Save and Close] to finish. If you make a mistake you can open the voter’s record back up and uncheck that box.
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Voted Status

Anderson, John
Has not voted today. Check (Voted) below to change status to
Page 1 of 1 Voted YES.

Voted

Save and Close

2
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Once the voter is marked as ‘voted’ the background of the row in their record will turn slightly yellow. My example is below.
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ALLIANCE 1-A £ Options

(@ Anderson

@ Previous & Next Page

Page 1 of 1

v Anderson, John H o

143 Ely StE \

Once the voter is flagged as voted the
background turns slightly yellow.
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Repeat these steps until the polling places close. The next steps show how to utilize the data that’s being collected. These final steps assume you have access to
your database and not just web passed polling access.

¢« Tip: To use the Mobile Base Camp web app more effectively take a look at this article. It will show you how to configure your device with
shortcuts to quick-launch the ‘app’, and how to keep the device screen on longer so you don’t need to log in over-and-over.

In your database navigate to the Voters list > Attribute tab.
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ot Settings  Help

Application Menu « [ <30 Search % Reset | 4 New ™ | ) CF @ | File ~ Edit ~ | & | SpInclude Other | Voters
El: =R} o
Taszks

| Favorites | General | Address | Household | Vote Histon| Atirbute [Eanvass | Poll | Lawn Sign | Contribute | Pledge | Event [ Log | Admin | saL |

i & Calendar/Tasks Include | Exclude

[
[j---% Canvassing @
=g Voter '
- {E Voters In precisely Attribute Yes Date From Date To MNote H
[ Minnescta Vater List @ In at least F=y Lawn Sign Requests F .
I
----- g Addresses o B Not - Hidden/Archived Records 4 P
----- Households =
= Place your order O E|
{8 Voter Relafionships P He S Pol Watch - Primary 2016 F
..... [ Lawn Signs of D selected 3 =
[j--: Contributions,/Pledges e —— = -
[+ Product Sales
2> Logs
-7 Polling
(-5 Communications
D"‘a Financial §§ Edit | % Include %7 Exclude % Sort % Format ~ DE Export & Print Detail |[@] Surmmary D] B Pivot
|
[-4® Disclosure e T
[j---% System Manager ]
Last First Address Zip Birth Reg
Incl 1D T e ]l Type Address City State Code Date Gend County CD SD LD id
(= (L

There will be a new attribute folder called “Poll Watch — Name of Election” with a new attribute item called “Voted”. In my example the attribute item is called
“Poll Watch — Primary 2016”.
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This attribute folder and item get created automatically once the polling feature
is activated for an election.

< Search W\Reset |4k New |[S|E 0 | L) ¥ & | File - Edit ~ | & | SpInclude Other | Voters

| Favorites | General Naddress | Household | Vote History | Attibute | Canvass | Poll | Lawn Sign | Contribute | Pledge | Event | Log | Admin | saL |

Include | Exclude \
h ¥

& _ In precisely Attribute Yes  Date From Date To Note ]

@ :n atleast B Lawn Sign Requests [ ®

|: :lnge @ Not - Hidden/Archived Records F P

rﬁ.ﬁ Eiii!n il . |:| E|
0 EHel & B Poll Watch - Primary 2016 O
of 0 selected =

To see everyone who’s voted in the current election check the attribute box in the ‘Yes’ column, and then click [Search]. In my example it returned 10 voter
records who had so far voted in my mock election.
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s Search

Reset o New |S|E m |[) ¥ ¢  File « Edit + | & |G Include Other | Voters

| Favortes | General | Address | Household | Vote History | 4 Attribute | Canvass | Poll

| Lawn Sign | Contribute | Pledge | Event | Log | Admin | s0L |

7 Include | Exclude

@ |

) In precisehy
@ In at least

) In range
@ inal

=

of 1 selected

Atribute Yes Date From Date To Note o ::1
#+= Lawn Sign Requests "] »
4=y Mot - Hidden/Archived Records O .
=) Place your order "] E| s
5 _Poll Watch - Primary 2016
I -Ef Voted
£ Social Netwnddng = K G

N

el 1D i o M #‘;gf“ Address t‘jg;“ Gty  Smte oP, Db Gender Couty  CD SD LD  Regld
i 2945 Hampshma- Ave N 1/1/1953 Hennepm 05 |45
285 Anderson Irene Elizabeth 2900 Douglas Dr N Apt 321 Crystal MN | 5b422 17171919 | F Hennepin 05 |45 |45B | 955376
164734 | Anderson Kely Linnea 3325 ¥enia Ave N Crystal | MN |55422 1/1/1965 Hennepin 05 (45 |45B | 947811
151595 | Anderson Bichard Allen 7001 30th Ave N Crystal | MN | 55427 1/1/1965 Hennepin 05 (45 |458 |4537115
14834 Haagenson | Gerald A 2709 Idaho Ave N Crystal MN | 55427 1/1/1934 | M Hennepin 05 |45 |45B | 955475
14531 Hastajs Peni Bae 6317 Valey PIN Crystal |MN |55427 17171961 | F Hennepin 05 |45 |458 | 1486475
158916 | Hansen Jesse Les 3345 Welcome Ave N Crystal MW | 55422 1/1/1585 Hennepin 05 |45 (458 |3841473
15575 Hansen Scott Joseph 2566 Kentuchky Ave N Crystal MM | 55427 1/1/1966 | M Hennepin 05 |45 |45B 1485898
18676 Hanson Leanne Gibson 2747 Brookridge Ave N Crystal MM | 55422 1/1/1962 | F Hennepin 05 |45 |45 | 1446042

™
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This basically sums up the steps to setup poll watching, using the mobile app, and run queries by the results as they’re collected. Continue reading to learn how

to build a pivot report off the data you collect - for instance you can get quick totals of voters by precinct, and getting even more advanced by adding in their
party types.

Steps to Build a Pivot Summary Report that Details Voter Counts by Precinct

In the Voters list search for everyone who has voted in your current election, you’ll do this by using the new attribute detailed in the steps above. In my example
it returned 3,157 voters for my mock election.
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Search and load all voters who have voted in your current election.

@) sSettings Help
Application Menu « || <39 Search P Reset | <5 New 05 | L) OF @ | File + Edit - | & |SgInclude Other | Voters |
[ElR:=A=Ne)

EES [ Favorites | General | Address | Household | Vote History | #* Attibite | Canvass | Poll | Lawn Sign | Contrbute | Pledge | Event | Log | Admin [ SQL |

[@-[5 Dashboard

- & Calendar/Tasks & Include | Exclude
[ m Canvassing 0
=g Voter '
[8F Vaters <— 1 ) In precisely Attribute Yes Date From Date To Note “| &
-[e] Minnesota Voter List #-=1 Lawn Sign Requests ] k.
----- @ Addresses =) Not - Hidden/Archived Records O -
""" @ Households =1 Place your order O El %
%W@ tjfj- Poll Watch - Primary 2016 [
""" Lawn Jigns of 1 selected
D"? Contributions/Pledges i L= ?m:::nmm l 1 =
-5 Product Sales /7

- Logs 2

- Polling
(-7 Communications
#-¢il Financial

[j--% Disclosure

[

% System Manager m Address Bith
Address Line 2 City State  Zip Code Date Gender  County CcD 5D

T)'pe

Reg Id

1141977 Hennepin 05 45 | 458 3599865

Click on the Format drop-down and select Columns.

KNOWLEDGE BASE www.trailblz.com/kb 28

Jo 57
100 Achteding Scoﬂ David @ 11281 Osage St NW Coon Haplds MM 5h433 1141979 Ancka

233 Agan Geralding Eddie @ 3542 Grimes Ave N Robbinsdale MK hh422 17141957 Hennepin 05 45 458 3882426
234 Agan Fobert Eard @ 3542 Grimas Ave N Fobbinsdale MM hb422 17141956 | M Hennepin 05 45 458 3882425
236 Anar Kenneth L @ 4204 Boone Ave N New Hope MM hh428-4837 1/1/1944 | M Hennepin 05 45 454 1149953
237 Agar Tanig v “ 4204 Boone Ave N New Hope MN | 55423-4837 1/1/1945 Henmepin |05 |45 | 45A 1149954
238 Agee Chris Andrew @ 1345 Major Dr Golden Valley MN 55422 14141974 | M Hennepin | 05 45 |458 1592924
240 Agee Paul Bemington @] 4071 Olivine Dr Eagan MN 55122 1141972 | M Dakota 02 51 |51A 1292458
241 Aggrey-Fynn Aua @ 9633 Thomas Ave N Brookhn Park MN | 55444 111977 Henmepin (03 |36 | 36B 3807628



http://www.trailblz.com/kb

& TrailBlazer

Organize, Leverage. Succeed.

How to Setup and Use the Mobile Poll Watching App

<3 Search % Reset | 4k New 0= L) ¥ @ | File ~ Edit - | 0 | 8aInclude Other | Voters
| Favorites | General | Address | Household | Vote History | 4% Attribute | Canvass | Poll | Lawn Sign | Contribute | Pledge | Event | Log | Admin | SQL |
A nclude | Exclude
) In precisely Attribute Yes Date From Date To
@
r?"l :n at least H-= Lawn Sign Requests " |
S B Not - Hidden/Archived Records F |
u . #-— Place your order ] |
I BHep H B Poll Watch - Primary 2016 ¥ |
of 1 selected b § Voted |
Gl-£=  Sncial Nehwndding 1 |
\\
&% Export [ Print [ Detail |[@ Summary [[] = |[E Pivot
Voters [ 3157 records found ] <System Format>
Columns... Address Birth
lnel 1D & Last Name Name S T | cug Line 2 City State  Zip Code Date
m |7 e Wendy - - — SEAI7 TR
= Adlegaard Wendy Add or remove columns, apply formatting, or specify column attributes, o o
100 Achteding Scott H Save oS ageE 3T 99T L i T )L L1 e 1/
233 Agan Geraldine ‘n@ Save As.., ¢ GGrimes Ave N Robbinsdale MM LT Wy 1/
23 Aagan Robert ) 2 Grimes Ave N Robbinsdale MM b2 1/
@ Assign as default..,
236 Aagar Kenneth - M Boone Ave N Mew Hope MM hh428-4837 1/
237 Agar Tanis W Eﬁ] 4204 Boone fAve N MNew Hope MM HhA28-4837 1/
238 Ages Chris Andrew Eﬁ] 1545 Major Dr Golden Valley MM ohdZx? 1/
m I II-_- — =-_lllllil E}. 'I .II- .I =lmk=lal [l I ol .’
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Under the Voter ‘table’ select Party from the list of columns.
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@ Column Selection

Columns | Attributes | Vote History | Format |
Tahble Columns [Voter]
% =" MonMenCaontributions

=
= NonMonContributions._Count
MonMenCeontributions BeforePeriod
MonMonCaontributionsDateRange
MonMonContributionsThisPeriod
MNonMonContributionsThruPericdEnd
MonMonContributionsYear ThruPericdEnd
Motes
Joined Tables Occupation

El"'ﬁ] Vater jonCode
! ) User
B} Address [Defautt Display]
=] @ ress [Home] Phone_Al2
Phone_Alt2Ext
Phone_AltExt

@ Address [Mailing] =
.5 Addrese [Renistratinn] Phone_Bus
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In the lower-left under the Joined Tables highlight the Precinct table, and then select Precinct Name from the list of columns on the right.
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@l Column Selection

Columns | Attributes | Vote History | Format |
Table Columns [Precinct]

% Include
PollCity
PollLocation
PollNationCode
PollState
PollStreet
PollStreet?
Poll\watchEnabled
Joined Tables PollZipCode
‘ =) Voter PrecinctCode
) User Biaciaaill

{7 Address [DefaultDisplay] Precinctame

Addreee [Renistratinn]
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Click [OK] once the columns for Precinct Name and Party have been selected.
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e Column Selection

Columns | Attributes | Vote History | Format |
Table Columns [Precinct]

% Include
PollCity
PollLocation
PollMationCode
PollState
PaollStrest
PollStreet?
Poll\watchEnabled
Joined Tables PollZipCode
! = Voter PrecinctCode
) User PrecinctlD
fEF) Address [DefaultDisplay] Precinctiiame

{5 Address [Home]

-fEF) Address [Mailing]
.F Addrses [Ranistrstinn]
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The new columns will display on the far right of the grid.

0 ) OF @ | File - Edit + | & |8pInclude Other | Voters

ousehold | Vot History | 4% Atrbute | Canvass | Pol | Lawn Sign | Contribute | Pledge | Event [ Log [ Admin | saL |

Agtribute es Date From Date To Note =1
FH-= Lawn Sign Requests "] »
(=) Mot - Hidden/Archived Records [l 7
=1 Place your order | E| ”
] = Poll Watch - Primary 2016 [Fl
AR Ef voted
[l Snpiz] Mebwadsing ] i

#f,gf“ Address ﬁ‘r’g"f City State  Zip Code g‘;*; Gender  County CD SD LD Reg Id Party Precinct Name

3040 Sumter Ave N Aot 102 |Crystal MN ; 77 Hernepin |05 |45 |45B |3539865 |REP CRYSTAL W-1 P02
E?h 11281 Osage 5t NW Coon Rapids £5433 1411979 Anoka 03 |36 |368 REP COON RAPIDS W-3 P-1
P | 3542 Grimes Ave N Robbinsdale MN | 55422 1/1/1857 Hernepin |05 |45 |458 | 3882426 | | DEM ROBBINSDALE W-4
@ | 3542 Grimes Ave N Robbinsdale MN | 55422 14171356 | M Hernepin |05 |45 |458 | 3882425 | | DEM ROBBINSDALE W-4
Pn | 4204 Boone Ave N New Hope MN | 554284837 14171344 | M Hernepin |05 |45 |45a [ 1149953 | | DEM NEW HOPE P-04
Pn | 4204 Boone Ave N New Hope MN | 554284837 14171345 Hermepin |05 |45 | 454 | 1149954 | |REP NEW HOPE P-04
| 1945 Major Dr Golden Valley  |MN | 55422 14141974 | M Hernepin |05 |45 | 458 | 1592924 | | DEM GOLDEN VALLEY P-1A
| 4071 Clivine Dr Eagan MN | 55122 14171572 | M Dakota 02 |5 |[mA  |1292488 | [DEM EAGAN P-5B
@ | 9832 Thomas Ave N Brookln Pak | MN | 55444 1411977 Hernepin |03 |36 |368 | 3807628 | |IND BROOKLYN PARK W-E P-6A
@ | 1820 York Ave N Golden Valley — |MN | 55422 14171852 | M Hernepin |05 |45 | 458 | 1106508 GOLDEN VALLEY P-01
=
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To get total voters by precinct with a breakdown of party, start by clicking the [Pivot] button.

< Search . Reset |4k New |S|E 0 | ) ¥ @ | File + Edit ~ | 0 | SpInclude Other | Voters |
Q
| Favorites | General | Address | Household | Vote History | & Attribite | Canvass | Poll | Lawn Sign | Contribute | Pledge | Event | Log | Admin | SaL |

A Include | Exchuie

@ I

i) In precisely Attribute Yeg Date From
© Inat least s =
g :: zlnge @0 Mot - Hidden/Archived Records
= Place your order
I Hel =8 15 Poll Watch - Primary 2016
of 1 selected i

4= Snrial Metwadcing

Address ; Birth
Address Line 2 City [ Create pivot table. ] Date

7 : [Wendy o | & [3040SumteraveN  [Apt102 [Cosal [MN [554272757 7[F |
--M-_WME-I

Under the Row Labels tab select Precinct Name.
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Create Pivot Table p——

Row Labels [Eolumn Labels | Data |

First Name I Pivot Table Rows

HH
i
D k - Column Heading

Incl |D | Precinct.Precinct... | Precinct Name
Last Name

Lo

MI

Party

Precinct Name
Reg Id

sD

State

Zip Code

Crwerall Progress
=
waiting for user input..

Step Progress
|-
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Under the Column Labels tab click Party.
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Create Pivat Table P

City i Pivot Table Columns

County i -
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LD
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Cwerall Progress
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Under the Data tab click Show count of occurrences and then click [OK].
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Organize. Leverage. Succeed.

Create Pivot Table p—

[#] Show count of occurrences Pivot Table Data

| Columrs e ey |

Incl

Owerall Progress
=
Wwaiting for user input...

Step Progress
[e=
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Your final pivot report will now display counts of voters, by party type, for each of the precincts you’'re polling. My example is below.
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COUNT() COUNT  COUNT  COUNT
DEM ) IND ()OTH () REP

h

0010 - 1-B BAUDETTECITY
0015 - 2-A GUDRID UNORG
0020 - 2-B BAUDETTE CITY
0040 - 4-A WHEELER UNORG
0045 - 5-B ZIPPEL UNORG
0050 - 5-A UNORG

0055 - 3-B WILLIAMS CITY
0065 - 2C UNORG

ACOMA TOWNSHIP
ACTON TWP.

ADAW-1

ADAW-2

ADAMS

ADAMS TWP.

ADRIAN

AKELEY

AKELEY TWP.
ALEXANDRIA W-5 P-1
ALVARADO

ANDOVER P-10

ANN LAKE TWP.

ANOKA P-2

APPLE VALLEY P-12
ARAGO TWP.

ARBO TWP

ARDEN HILLS P-1

ARGYLE

ARTHUR TWP.

ATHENS TWP

ATWATER

AUGSBURG TWP.
AURDAL TWFP

AUSTIN TWP.

AUSTIN W-1 P1

AUSTIN W-1 P-2

AUSTIN W-2 P-1

AUSTIN W-2 P-2

AUSTIN W-3 P-1

BLUSTIN W-3 P-2
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From here you can print the report, export, or graph it. This concludes all the steps, the related resources below link to a variety of other articles and videos that
have to do with the Mobile Base Camp app.

0009

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

Article: Tips and Tricks for using Mobile Base Camp — Add Shortcuts to your Home Screen, Adjust Device Settings to Keep the Screen on, and More

Article: Mobile Base Camp — Mobile Canvassing

Article: Mobile Base Camp — Contact Search

Article: Add an Election to Your Trail Blazer Database
Article: Election Day Procedures | Poll Watchers
Video: Mobile Canvassing

Video: Canvass Your Neighborhood With Our Mobile Canvassing App

Trail Blazer Live Support

© Phone: 1-866-909-8700
® Email: support@trailblz.com
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Kl Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.

Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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